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Preface to This Guide

This guide describes how to operate the Hospital for Sick Children CatX 
Workstation when it is in the POLARA configuration. See “Workstation 
Configurations” on page 1-4 for a descriptions of the configurations.

Who Uses This Guide This guide is for operators of the Hospital for Sick Children CatX 
Workstation. This guide assumes the reader has been trained on the safe 
operation of the system by Thermo Electron Corporation Laboratory 
Automation and Integration. This guide is not intended as a self-teaching 
tool.

How to Use This
Guide

This manual is task-based and uses navigational aids to help you quickly 
find the topics and information you need. 

Before following instructions in a section, read the entire section first.

This guide consists of the following chapters:

• “Introducing the System” which introduces the system and provides an 
overview of its basic components.

• “Safe Use of the System” which describes safety directives with which 
you and all operators of the system must be familiar.

• “Using the System” which describes requirements that must be met and 
tasks that must be performed outside of the POLARA operating 
environment.

• “Maintaining the System” which describes periodic inspection, cleaning, 
and maintenance.

Note: Throughout this manual warnings are marked by a "!" symbol in the 
left margin. Failure to comply with these warnings can result in system 
errors, memory loss, damage to the robot and its surroundings, or injury to 
personnel. ▲
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• “Troubleshooting” which describes system-level troubleshooting 
procedures, instructions for contacting Thermo Electron customer 
support, and references to other documentation.

• “Index” which contain an index to subjects in this guide.

Units Used in This
Manual

Throughout this manual, measurements are given in Metric SI units.

For More Information This manual contains the information you need to operate the system as a 
whole. For details on using the POLARA software to develop methods, and 
schedule and perform runs, see the POLARA 2.3 user guides.

Training We offer courses at our facility in Burlington, Ontario Canada, or on-site at 
your facility. For more information, contact the Thermo Electron Customer 
Support Group.

Contacts You can contact Thermo LAI personnel in any of the following ways.

Surface Mail/Shipping Thermo Electron Corporation
Laboratory Automation and Integration
5344 John Lucas Drive
Burlington, Ontario L7L 6A6
Canada

Telephone 1-905-332-2000 (voice)
1-800-365-7587 (voice: toll free in Canada and United States)
1-905-332-1114 (facsimile)

E-Mail Sales: sales.labautomation@thermo.com
Customer Support and Training: services.labautomation@thermo.com
General: info.labautomation@thermo.com

World Wide Web www.thermo.com
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Chapter 1 Introducing the System

The Hospital for Sick Children CatX Workstation station is a modular and 
expandable system for high throughput screening.

This chapter introduces the system and provides an overview of its basic 
components. It includes the following topics:

• “System Instruments and Peripherals” on page 1-2

• “System Components” on page 1-6

• “Master Control Panel” on page 1-11

• “POLARA System Software” on page 1-13

• “CRS DataHandler Software” on page 1-14
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System Instruments
and Peripherals

The Hospital for Sick Children CatX Workstation system includes the 
following instruments and peripherals:

Figure 1-1. Hospital for Sick Children CatX Workstation layout

• One Thermo CRS Regrip station (built in to CatX base)

• One Thermo CRS Lidder

• One Thermo Cytomat 2 incubator

• One MicroScan MS-3 Bar Code reader

• One PerkinElmer Evolution P3 liquid handler

• One PerkinElmer Envision reader

• One PerkinElmer Multiprobe pipettor (note: this instrument is not 
integrated into the POLARA workspace)
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• One PerkinElmer PlateStak storage unit

• One Biotek ELx405 washer

The system uses an Articulated Robot mover controlled by the POLARA 
scheduling software, to move microtitre plates between instruments. For 
details on the components of the system, see “System Components” on 
page 1-6.

For details on the operation of the instruments, refer to the user guides 
supplied with the instrument.
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Workstation
Configurations

Thermo personnel have integrated this workstation into two configurations:

• A POLARA system consisting of all instruments except the PE 
Multiprobe.

• A WinPREP system consisting of the PE Evolution, Multiprobe, and 
PlateStak.

The instruments that can be used in each configuration are shown in 
Table 1-1.

The two configurations can be used at the same time only when POLARA is 
running a method whose profile does not include the PlateStak and 
Evolution.

This document provides user information for operating the POLARA 
configuration only.

To setup a configuration, follow these procedures:

To setup a POLARA configuration 1. If the PlateStak is in the profile selected for your POLARA method, 
change the PlateStak serial port switch so POLARA can communicate 
with the PlateStak.

2. If the Evolution is in the profile selected for your POLARA method, 
ensure that its scripts used in POLARA methods do not access the 4 
nests closest to the PlateStak diving board.

3. Ensure the Evolution P3 pipe server is running on the Evolution 
computer.

Table 1-1. Instrument usage by configuration

POLARA only Common instruments WinPREP only

Thermo Cytomat 2 incubator PE Evolution PE Multiprobe

PE Envision reader PE PateStak

Biotek ELx405 washer

MicroScan MS-3 Bar Code reader

Thermo CRS Lidder

Thermo CRS Regrip station
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4. Ensure the EnVision pipe server is running on the Envision computer.

5. Continue using the POLARA configuration as described in Chapter 3: 
“Using the System”.

To setup a WinPREP
configuration

1. If POLARA is running, ensure it is not running methods whose profile 
includes the PE Evolution and PlateStak.

2. Change the PlateStak serial port switch so that WinPREP can 
communicate with the PlateStak.

3. Continue using the WinPREP configuration on the WinPREP 
computer according to PerkinElmer requirements.
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 System Components Each  system consists of the following main components:

• Tables, which are customer supplied.

• The system computer, which runs the POLARA software that provides 
high-level control of all hardware in the system and which collects the 
data gathered during runs. Each instrument on the table is connected to 
the system computer through a serial port or via the system LAN.

The system computer also runs application software provided by the 
manufacturers of the instruments in the system.

Some systems use one or more additional computers to run application 
software and to communicate with selected instruments. All computers 
are connected through a LAN.

• The  container transport consists of the following components:

• The Articulated Robot holds containers using gripper fingers and 
moves the containers between instruments. Articulated robots 
consist of ‘linked joints’ that rotate or slide to change the location of 
its gripper.

• The C500C controller directs the motion of the robot arm and 
provides power and safety circuits. The controller is built into the 
base of the CataLyst Express.

Note The container transport also includes an E-Stop circuit into which 
instruments can be integrated. ▲

• The serial expander provides an interface through which instruments 
can perform serial communications with the system computer.

• The GPIO expander provides an interface through which the system 
computer can control digital outputs and respond to digital inputs. For 
example, an instrument with automatic doors can be interfaced through 
the GPIO expander, enabling the system computer to open and close 
the doors, and determine when the doors are open or closed.

• The Master Control Panel provides the system operator with an E-Stop 
button with which to cut power to the moving components in an 
emergency, and system and motor power status and reset buttons.

Your AR system may also include the following components:



Introducing the System
System Components

Thermo Electron Corporation LOR772 System User Guide 1-7

• A system LAN hub, into which the network interfaces of the 
controllers, the system computer, and possibly some instruments are 
connected.

• A Belkin KVM Switch that enables the system keyboard and display to 
operate computers in the system LAN.

• Uninterruptible power supplies (UPS), which provide continuous 
power to the system. If an interruption occurs in the main power 
supply, the UPSs maintain power for up to 30 minutes.

• Guarding, consisting of plexiglass barriers that block access to moving 
parts of the transport.

For details about Dimension4 components, see the following topics:

• “Power Input Requirements” on page 1-8

• “Fuse and Circuit Breaker Requirements” on page 1-9

• “Environmental Conditions” on page 1-10
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Power Input Requirements Controllers require the power inputs listed in Table 1-2.

Table 1-2. Controller input power ratings

Description Rating

Input voltage 110/115/230 VAC, ±10%

Line frequency 50-60 Hz

WARNINGThe controller must be grounded! The AC cord supplied with 
the controller provides the proper grounding terminal. Do not cut off the 
third terminal from the AC cord set. ▲
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Fuse and Circuit Breaker
Requirements

Refer to the C500C Controller User Guide or the CataLyst Express User Guide 
for fuse and circuit breaker requirements of AR controllers.
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Environmental Conditions The CatX requires the environment conditions shown in Table 1-3.

Table 1-3. CatX environmental requirements

Environment Condition Requirement

Relative humidity Below 50%, non-condensing

Temperature 10-40 °C

Ventilation A minimum of 11.5 cm (4.5 in.) clearance between the 
grills at the rear of the controller and your enclosure

Atmosphere Clean, low dust; dry office/lab environment

Installation location for INDOOR use only



Introducing the System
Master Control Panel

Thermo Electron Corporation LOR772 System User Guide 1-11

Master Control Panel You use the Master Control Panel (MCP) to control power to the .

The MCP consists of a small metal box connected to the .

Figure 1-2. The Master Control Panel (MCP)

Figure 1-3. MCP controls

The MCP provides the following system power functions:

E-Stop button

Arm status 
indicators

Brake release
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• An EMERGENCY STOP (E-Stop) button that, when pressed, 
immediately cuts power to the robot arm (but not necessarily to the 
instruments)

To understand the Arm status indicators and Brake release button, refer to 
the “Using the E-Stop Control” section in your CataLyst Express User Guide.
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POLARA System
Software

POLARA is an application for Microsoft Windows that provides Hospital 
for Sick Children CatX Workstation users with an easy to use graphical 
interface for operating and managing the system, and for developing and 
scheduling methods.

Figure 1-4. POLARA provides a graphical user interface to operate the system.

For details about using POLARA, read the POLARA user guide or choose 
Contents in the POLARA Help menu to display POLARA’s online help.
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CRS DataHandler
Software

The Hospital for Sick Children CatX Workstation system includes a 
Windows application called DataHandler that reads the data log. 

Before a run in POLARA, go to the Site Parameters and ensure the correct 
validation and results directories are entered. See “Starting a Run” on 
page 3-7.
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Chapter 2 Safe Use of the System

Before using the Hospital for Sick Children CatX Workstation, ensure that 
you and all operators of the system are familiar with the safety directives in 
this chapter.

For details, see the following topics:

• “Built-in Safety Features” on page 2-2

• “Ensuring Safe Use of the System” on page 2-3

• “Operating the System Safely” on page 2-5

• “Triggering an E-Stop” on page 2-7

• “Adding E-Stops to the System” on page 2-9

CAUTION This manual describes the safe use of Thermo Electron 
components of the Hospital for Sick Children CatX Workstation system. 
Refer to the manufacturer’s instructions for all other Instruments and 
devices in your system. ▲
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Built-in Safety
Features

The following safety features are standard for all POLARA Systems:

• Emergency Stop (E-Stop) buttons enable you to immediately halt 
container transport motion.

• The run-time Monitor window displays information during the 
progress of a run, including error messages and warnings.

• If POLARA detects that operator intervention is required during a run 
(for instance, if a non-standard container needs to be repositioned or 
removed), it suspends the run and alerts the operator.

The Hospital for Sick Children CatX Workstation system also includes the 
following safety features:

• Automatic telephone and e-mail paging notifies system personnel of 
error conditions that occur during a run.



Safe Use of the System
Ensuring Safe Use of the System

Thermo Electron Corporation LOR772 System User Guide 2-3

Ensuring Safe Use of
the System

Before using the system, you must be trained in its safe use by Thermo 
Electron.

You must also have a thorough understanding of the following subjects:

• The operation of the POLARA software

• How to perform a run and monitor its progress

• How to safely operate the DM container transport

• How to safely operate each of the instruments on the table

• How to respond to warnings and error messages

• How to use E-Stop buttons

• How to recover the system after an E-Stop is triggered or a container 
mover error occurs

The user guides supplied with your system provide the information you 
need to understand these subjects. Read all of it before using a POLARA lab 
system.

When using the system, you must observe the following safety guidelines:

• Do not allow untrained persons to control the system.

• Any person who is authorized to operate the container transport must 
be fully trained in container transport safety and the use of container 
transport motion commands.

• Train any person who uses the laboratory system in the dangers and 
risks associated with each instrument and with the laboratory system as 
a whole.

• If the biological or chemical process that you are investigating involves 
hazardous materials, ensure that operators are aware of the dangers and 
take appropriate measures to minimize risks.

CAUTION The AR container transport is not designed to handle volatile 
or flammable agents. Perform a risk analysis before the system is installed 
and determine whether your site requires safety measures (such as 
ventilation or guarding) in addition to those described in the following 
sections. ▲
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• Any person who can approach the container transport hardware must be 
aware of the following rules:

• Never place any body part within the reach of a mover when mover 
power is on. The mover can move unexpectedly at high speeds. 

• Do not touch automated components when the system is running.

• Never operate the system if you believe any substance has dripped 
into or otherwise entered the container transport hardware.

• If the system is being serviced or modified, or is acting abnormally, 
ensure that it is clearly labeled as “Out of Service” to prevent accidental 
use.

• Following any change in lab system hardware, thoroughly test the 
changes and perform a sample run before making the system available 
for use.
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Operating the System
Safely

Observe the following precautions when operating or approaching the 
system.

• Wear safety glasses when in the immediate vicinity of the system. These 
protect users from possible splashing of the contents of the microplates.

• When cleaning the waste chute, wear appropriate protective personal 
equipment, such as gloves, safety glasses, a lab coat, and a breathing 
apparatus.

• Keep loose clothing and long hair away from moving parts.

• Remove jewelry, such as rings, bracelets, and necklaces, before operating 
the system.

This symbol, which is placed at several locations on the system, 
indicates pinch point hazards. Avoid placing any part of your body near 
these locations when the system is online. ▲

This symbol indicates a burn hazard. There is a hot surface inside. Allow 
to cool before servicing. ▲
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Understanding Warnings
and Error Messages

During runs, the system issues warnings and error messages when it 
encounters a condition that should be noted or corrected.

Note For details on how to respond to specific warnings and error messages, 
see “Setting Up and Performing a Run” in the POLARA online help or user 
guide. ▲

Warnings The system issues a warning when it encounters a condition that should be 
noted and reported but is not serious enough to warrant suspending the 
run. It alerts operators to a warning in the following ways:

• A warning appears in the Messages tab of the POLARA Monitor 
window and the Monitor warning status indicator turns yellow.

Error Messages The system suspends a run when it encounters an error that requires 
intervention. It alerts operators in the following ways:

• Depending on the type of error, a message box may appear on the 
screen.

• An error message appears in the Messages tab of the Monitor window 
and the Monitor error status indicator turns red.
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Triggering an E-Stop In case of emergency, operators can quickly halt all container transport 
motion by triggering an emergency stop.

To stop the system in case of
emergency

• Strike the E-Stop button on the Master Control Panel.

The container transport halts, indicating that the system is waiting for 
manual intervention. When POLARA detects that a mover is no longer 
responding to commands, it suspends the run and displays a message to 
the operator.

You then have the option to abort the run or attempt recovery.

To recover from an E-Stop 1. Inspect the system components. If any are physically damaged, recovery 
is not possible. Click Abort in the message box presented by POLARA.

2. Verify that it is safe for the run to continue:

• Clean up any spills. If any containers have been misplaced or 
dropped, replace them as needed.

• Check the integrity of the run. Some processes are extremely 
sensitive to temperature changes or contaminants. If necessary, take 
note of any samples which might have been affected.

• Make sure the container transport work space is free of obstructions.

3. Twist the E-Stop button to reset it.

4. Press the ARM POWER button on the front panel of the CataLyst 
Express. The ARM POWER indicators on the front panel and the 
E-Stop control light.

WARNING Other instruments may not stop moving when you trigger an 
E-Stop. Before you operate your POLARA system, ensure that you know 
how each instrument responds to an E-Stop. ▲
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5. At the system computer, click Retry (or any other option that will allow 
you to proceed). The run continues.
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Adding E-Stops to the
System

To improve safety within your workcell, you can connect additional 
E-Stops. Refer to your CataLyst Express User Guide chapter “CataLyst 
Express Ports”.
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Chapter 3 Using the System

You perform runs on the Hospital for Sick Children CatX Workstation 
using POLARA. However, there are some requirements that must be met 
and tasks that must be performed outside of the POLARA operating 
environment. For details, see the following topics:

• “System Requirements” on page 3-2

• “Bringing the System Online” on page 3-3

• “Taking the System Offline” on page 3-5

• “Selecting the Computer to Operate” on page 3-6

• “Starting a Run” on page 3-7
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System Requirements The Hospital for Sick Children CatX Workstation system requires specific 
levels of air pressure, electrical power, and user capabilities to function safely 
and reliably.

For details, see the following topics:

• “Air Supply” on page 3-2

• “Electric Power” on page 3-2

• “User Capabilities” on page 3-2

Air Supply The system requires an air supply of 80-100 psi.

Electric Power This system does not include UPSs monitored by POLARA so POLARA 
cannot warn users when power is failing. Users must monitor the site 
location power supply. To halt a run, see the “Halting a Run” section in the 
“Setting Up and Performing a Run” chapter of your POLARA User Guide.

User Capabilities Before operating this system, you must be trained in its safe use by Thermo 
Electron. For details on training offered by Thermo Electron, see “Training” 
on page 2 in the Preface.

You must also have a thorough understanding of the following subjects:

• How to use the POLARA software that controls the system. For details, 
see the POLARA user guide.

• How to safely operate each of the instruments on the table. For details, 
see the user guide supplied with each instrument.

• How to safely operate the container transport: the robot arm and its 
controller. For details, see “Safe Use of the System” on page 2-1.
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Bringing the System
Online

Bringing the system online readies it for performing runs. To bring the 
system online, make the instruments and computers ready and test the 
Emergency Stops.

To make instruments and
computers ready

1. Confirm that the uninterruptible power supplies (if any) are receiving 
power from the main AC supply, as described in their documentation.

2. Turn on the air supply, if present, by rotating the air regulator valve 
clockwise until it reads “SUP.”.

3. Power on the POLARA computer and all other instrument computers.

4. Power on all instruments.

To test the Emergency Stops 1. Test the E-Stop chain by taking the following steps:

a. Press the E-Stop button on the Master Control Panel (MCP).

b. Inspect the movers. All mover power beacons should be OFF.

2. Reset the E-Stop button by twisting it clockwise until it pops up.

3. Press and hold the RESET button on the MCP until it turns green.

4. Press and hold the MOTOR POWER ON button on the MCP until it 
turns green.

CAUTION If any mover power beacon remains lit when the E-Stop button 
has been pressed, do not finish bringing the system online! Inform all system 
users that the system is unavailable and contact Thermo Electron Customer 
Support immediately, as described in “Contacting Thermo Electron 
Customer Support” on page 5-7. ▲
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5. Inspect the movers. All mover power beacons should be ON.

The system is now ready to perform POLARA runs.

Note Some runs require you to perform additional setup of some 
instruments. For details, see the setup instructions displayed by POLARA 
before each run. ▲

CAUTION If any mover power beacon remains OFF when MOTOR 
POWER ON button is green, do not operate the system! Inform all system 
users that the system is unavailable and contact Thermo Electron Customer 
Support immediately, as described in “Contacting Thermo Electron 
Customer Support” on page 5-7. ▲
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Taking the System
Offline

Taking the system offline brings it to a state in which only the UPSs (if any) 
remain powered.

To take the system offline 1. Confirm that the system has completed all POLARA runs.

2. Exit POLARA by choosing Exit in the POLARA File menu.

3. Shut down each instrument as described in its documentation.

4. Remove all microtiter plates and other sample containers from the 
system.

5. Shut down the system and instrument computers.

6. Power off each controller by switching the POWER button to its ‘0’ 
position.

7. Turn off the system air supply by turning the air regulator valve 
counter-clockwise to the “OFF” position.

CAUTION Do not exit POLARA by shutting it down in the Windows 
Task Manager! Doing so leaves some POLARA mover control components 
still running. ▲

CAUTION If you disconnect the controller’s AC power supply before all 
indicator LEDs on the controller are dark, you might corrupt the 
controller’s system files! The POWER button does not immediately 
remove power to the controller; it simply commands the controller to 
perform a shutdown. ▲
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Selecting the
Computer to Operate

Some systems use additional, non-POLARA, computers to communicate 
with instruments and to run instrument software.

The Hospital for Sick Children CatX Workstation system has 2 additional 
computers connected in a LAN:

• Envision computer

• Evolution computer

The Belkin KVM Switch enables a single keyboard and display to operate 
the computers used in the system LAN. Each computer is connected to one 
of Port Numbers.

A computer must be powered on and correctly connected to select it. See the 
Belkin documentation for operation details. In brief, you can use any of 
following methods to select a computer Port Number:

• Press a front panel button on the Belkin KVM switch.

• Press the keyboard Scroll Lock twice and the Up or Down arrow key to 
switch to the previous or next Port Number, respectively.

• Press the keyboard Scroll Lock twice and a number key to select a 
specific Port Number.

• Press the keyboard Scroll Lock twice and the space bar to display a list of 
Port Numbers from which you can select a specific Port Number.

The computers are connected to Belkin Port Numbers as shown in 
Table 3-1.

Table 3-1. Computer and Belkin Port Number mapping

Computer Belkin Port Number

POLARA 1

Envision 2

Evolution not connected to Belkin switch
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Starting a Run To access POLARA, use the Belkin KVM switch to select the POLARA 
computer on Port Number 1 (see “Selecting the Computer to Operate” on 
page 3-6).

When the system is online, start the POLARA application and prepare the 
instrument software. To perform runs, refer to your POLARA Guide.

To start POLARA 1. On the system monitor, use the Belkin switch to select the POLARA 
computer.

2. Use one of these methods to start POLARA:

• In the Start Menu, choose Programs > CRS Robotics > POLARA 
V2.3.

• Double-click the POLARA 2.3 icon on the Windows desktop.

Tip You can get help at any time in POLARA by choosing Contents in the 
POLARA Help menu. ▲

To setup data validation 1. On the system monitor, use the Belkin switch to select the POLARA 
computer.

2. Start POLARA and in the View menu, choose Options. . . to display 
the Options dialog box.
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3. Select the General tab to and click Site Parameters to display the Enter 
Site Parameters dialog box:

4. Enter or change the following information:

• Assay Name

• Operator Name

• Output Directory 2, to put a copies of Envision output data files 
into another directory. Choose Browse to navigate to another 
directory.

5. Select Delect original Envision file to delete Envision data files 
between POLARA runs. The files are delected only after they are copied 
to the output directories specified above.

6. Choose OK.
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Chapter 4 Maintaining the System

The system requires little daily maintenance other than inspection and 
cleaning. For system maintenance, see the CataLyst Express User Guide 
chapter called “Maintenance Procedures”.

For additional details, see the following topics:

• “Lockout/Tagout Procedures” on page 4-2

• “Monthly Maintenance” on page 4-3
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Lockout/Tagout
Procedures

For electrical lockout, unplug the power cords from every instrument and 
controller.

For air lockout/tagout, turn off the air supply by rotating the air regulator 
valve. This also relieves the pressure in the system. Apply a lockout/tagout 
boot.

WARNINGEnsure your laboratory personnel use Lockout and Tagout 
procedures for air and electrical main connections during 
maintenance. ▲
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Monthly Maintenance Once every month, test the E-Stop chain to ensure that all movers and other 
components connected to the E-Stop chain have their power cut when the 
E-Stop is triggered.

To test the E-Stop chain 1. Take the system off-line, as described in “Taking the System Offline” on 
page 3-5.

2. Bring the system online, as described in “Bringing the System Online” 
on page 3-3.





Thermo Electron Corporation LOR772 System User Guide 5-1

Chapter 5 Troubleshooting

For troubleshooting procedures, see the “Troubleshooting” chapter in your 
CataLyst Express User Guide. For capturing problem data and error messages 
prior to getting help, see:

• “Recovering from a Mover Collision” on page 5-2

• “Getting Help” on page 5-3
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Recovering from a
Mover Collision

If a mover collides with an object, its controller removes power to the mover. 
When POLARA detects that a mover is no longer responding to commands, 
it suspends the run and displays a message to the operator.

To recover from a mover collision 1. Inspect the mover and other system components for physical damage.

2. If any damage has occurred, click Abort in the POLARA message 
window to abort the run. Contact Electron Customer Support as 
described in “Getting Help” on page 5-3.

3. If a container has become misaligned in the gripper, take the following 
steps:

a. Restore power to the arm.

b. Start CROSnt (see the topic “Starting CROSnt” in the “Defining 
Motion in AR Workspaces” chapter of your POLARA Administrator 
Guide).

c. Start ash for the instrument where the collision occurred.

d. With a trained user standing by to catch the container, open the 
gripper with the go command.

e. If necessary, move the arm away from the instrument so that the 
gripper is outside the instrument nest. Limp the arm or use joint 
commands very carefully to move the arm.

f. Move the arm to the instrument’s safeloc location.

g. Follow instructions in the POLARA message window for placing 
containers.

4. If a container is out of position from its nest, and if it is still eligible to 
be processed in the run, replace or reposition the container in the nest.

5. Click Resume in the POLARA message window to resume the run.

WARNING Ensure containers are replaced or repositioned so that wells 
are correctly located. For example, if a dispenser fills wells differently by 
column, be sure to position the A1 well as required by your assay. ▲
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Getting Help You can speed the resolution of any problems you might have with your 
system by performing the following steps:

• “Preparing to Contact Thermo Electron” on page 5-3

• “Gathering Problem Data” on page 5-4

• “Capturing System Error Messages” on page 5-5

• “Contacting Thermo Electron Customer Support” on page 5-7

Preparing to Contact
Thermo Electron

You can get your system back up and running more quickly if you can 
collect crucial information before contacting Thermo Electron Customer 
Support.

To prepare to contact Thermo
Electron Customer Support

1. Gather problem data. For details, see “Gathering Problem Data” on 
page 5-4.

2. E-mail any relevant files or information to 
services.labautomation@thermo.com

• Include a description (or screen captures) of any errors or messages 
reported by the system. For details on how to capture messages, see 
“Capturing System Error Messages” on page 5-5.

• Include a brief description of the circumstances surrounding the 
failure.

Tip E-mailing supporting information to Customer Support before 
telephoning can help them troubleshoot your problem more quickly. ▲



Troubleshooting
Getting Help

5-4 LOR772 System User Guide Thermo Electron Corporation

Gathering Problem Data By providing detailed information about the circumstances of the problem, 
you can help the Thermo Electron Customer Support Group to identify the 
cause more quickly, leading to a faster resolution.

To gather problem data 1. Make a screen capture of any error messages that appear during system 
startup and shutdown. See “Capturing Graphics” on page 5-6.

2. Try to repeat the problem and capture any error messages that occur.

Tip If you cannot engage arm power, make sure that all devices in your 
E-Stop chain are closed. If you still cannot engage arm power, it is likely 
that you have a mechanical problem with the mover. ▲

3. Make copies of the POLARA log files are described in your POLARA 
User Guide in section “Making Backup copies of POLARA Logs” in the 
chapter “Getting Help with POLARA”.

4. Use a compression package like WinZip or Stuffit to zip screen captured 
images, text files, and log files. They reduce the total file size, making it 
much easier to e-mail.
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Capturing System Error
Messages

It can be useful to capture system error messages to provide a record of the 
problem.

For details, see the following topics:

• “Capturing Text” on page 5-5

• “Capturing Graphics” on page 5-6

Capturing Text If the message is displayed as text in the CROSnt window, it is most 
convenient to copy it and paste it into a text editor such as Notepad. 

Tip Saving a message as text makes it easier to read. The file size is also much 
smaller than for a graphic screen capture. ▲

To capture text from CROSnt 1. Right-click in the title bar of the CROSnt window. You will see the 
following menu.

2. Choose Edit > Mark. Your cursor changes to a solid cursor. Scroll up to 
the top of the window, then click and drag with your mouse to 
highlight a section. When you have selected the text that you want, 
press Enter.

3. Open Notepad (or another text editor). In the Edit menu, choose Paste 
to paste the text from the CROSnt window. 

4. Save the text file.
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Capturing Graphics If the message is displayed as part of a dialog box or window, you can use 
Windows’ print screen function to capture it and paste it into another 
program.

To perform a screen capture 1. With the message box (or window) that you want to capture displayed 
on screen, press Ctrl+PrintScreen.

2. On the Windows Start Menu, choose Programs > Accessories > Paint to 
open the Microsoft Paint program.

Tip You can paste the image into any Microsoft program, including 
Microsoft Word and Outlook mail. Paint generally provides a smaller 
file, when zipped. ▲

3. In the Paint Edit menu, choose Paste. Do not stretch or re-size the image 
as this will make it hard to read.

4. In the Paint File menu, choose Save. Use the Save As dialog box to 
choose an appropriate directory and enter a filename for the image.

Tip To minimize file size, save it as a JPEG (.jpg) or use a compression 
package like WinZip or Stuffit to zip screen captured images. The latter 
reduces the file size by about 90%, making it much easier to e-mail. ▲
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Contacting Thermo
Electron Customer Support

The Thermo Electron Customer Support Group can be reached by 
telephone, fax, or e-mail from 8 am to 5 pm, EST.

To telephone 1-905-332-2000 (voice)

1-800-365-7587 (voice: toll free in Canada and United States)

To fax 1-905-332-1114 (facsimile)

To e-mail Customer Support: services.labautomation@thermo.com
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